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            Menu Bar

To Begin
Select Default Dreamweaver
MX workspace-OK

Document Window

• When you start Dreamweaver the largest area on your screen will be the document
window. This is where you will design your web pages in the WYSIWYG interface (What
you see is what you get!)

• Parts of Document window
1. Toolbar-holds shortcuts
2. Content area-middle bar
3. Status Bar-bottom bar

• You can type directly into the document window or use the Insert panel or Insert menu to
add text, graphics, or links to pages. The flashing cursor in the document window shows
where the current insert  point is located. Layout view mode discussed later will show you
how to have more control on your page layout.

• Manipulating text, graphics-similar as word processors-select graphic or highlight text and
cut, copy, paste. 



Select Basic tab

Figure 3
Browse to where you want to
create a web folder for your work.

Set up a local site 

The most common approach to creating a website using Dreamweaver is to create and edit pages
on your local drive, and then upload copies of those pages to a remote web server to make them
publicly available. We can also copy our files right into First Class Home Page as a simple
alternative to the ftp process.

You’ll create a site definition using the Site Definition dialog box. You can fill in this dialog box
in either of two views: Basic or Advanced. The Basic approach guides you through site setup step
by step

To define a site: 

1. Choose Site > New Site. (That is, choose New Site from the Site menu.)

The Site Definition dialog box appears. 

2. If the dialog box is showing the Advanced tab, click Basic.

The first screen of the Site Definition Wizard appears, asking you to enter a name for your
site. 

3. In the text box, enter a name to identify the site within Dreamweaver. The name can be
anything you want. For example, you
could name the site your school name.



4.  Click Next to proceed to the next step. 

5.  The next screen of the wizard appears, asking if you want to work with a server technology. 

Select the No option to indicate that for now, this site is a static site, with no dynamic pages.

Click Next to proceed to the next step. 

6.   The next screen of the wizard appears, asking how you want to work with your files. 

Select the option labeled “Edit local copies on my machine, then upload to server when ready
(recommended).” 

There are a variety of ways that you can work with files during site development, but for the
purposes of this lesson, choose this option. 

7.  The text box allows you to specify a folder on your local disk where Dreamweaver should
store the local version of the site’s files. It’s easier to specify an accurate folder name if you
browse to the folder rather than typing the path, so click the folder icon next to the text box. 

At school make sure you place your folder in your “h” drive.

 Click Next to proceed to the next step. 

8.  The next screen of the wizard appears, asking how you connect to your remote server. 

For now, choose None from the pop-up menu. Click Next to proceed to the next step. 

The next screen of the wizard appears, showing a summary of your settings. 

Click Done to finish.

    9.  An alert appears to tell you that Dreamweaver will create a site cache. The site cache is a way
for Dreamweaver to store information about the site, to make various site operations faster.

10. Click OK to allow Dreamweaver to create the site cache.

The Site panel now shows the new local root folder for your current site, and an icon to let you
view all of your local
disks in a hierarchical
tree view. The icon is
labeled Desktop
(Windows)



The Site panel normally shows all the files and folders in your site, but right now your site doesn’t
contain any files or folders. When there are files in a site, the file list in the Site panel acts as a file
manager, allowing you to copy, paste, delete, move, and open files just as you would on a
computer desktop
Tool Box of Web Elements~Insert

Common
This is most common of the design
elements.  This includes images, tables, embedded objects, navigational bars and image rollovers.

Hyperlink-adds a common web link to a page

Email link- Inserts a link into the document so the user can email a specific contact.

Anchor-Inserts a bookmark into the document so that a link can be created that attaches directly to
a specific portion of the page. 

Table-The use of tables can give you true control over the content placement within your page.

Layer-Used to position elements to exact pixel coordinates, resulting in extremely precise layouts.

Image- Using the image tool, you can quickly insert an image into your document

Image placeholder-Know you want to add an image into your document, but don’t have the file ready
yet? Just add a placeholder for now.

Fireworks HTML-The macromedia Fireworks image optimization program generates its own
HTML for rollover images, menu bars, and other special effects.  To insert an HTML file built by
Fireworks into you HTML, click this icon.

Flash-Easily insert Macromedia flash elements into a document. (Vector animation)

Rollover Image-Signal on/off states of buttons on Web sites, click on the rollover icon, tell
Dreamweaver MX what you want the on and off state images to be for your button.

Navigation Bar-Clicking this icon enables you to quickly create a rollover navigation bar out of a
series of on and off images. 

Horizontal rule-Creates dividing horizontal lines.

Date-Inserts the date and/or time into the document.  Includes an option to automatically update the
date as soon as the document is saved.

Tabular Data-A common use of tables is to create an online display of existing data such as
spreadsheet calculations.  You can easily import a text file containing this data directly onto your
web.   

Comment-Allows you to insert text that won’t be visible on the page when viewed with a browser.

Tag chooser-Used for picking tags to insert into the HTML document.  



Layout
Layout Cell-draw a table cells in an empty area of your page or inside a layout table.

Layout Table-draw a table in an empty area of your page or inside another table.

Text
Text formatting functions;
no visual HTML objects.  Useful mainly to those working directly with source code.

Note:The properties on the bottom left hand side of your working area to find your word editing menu.

Tables
Inserts the table objects (also available in the Common panel) and provides shortcuts for inserting the
HTML source code.

Frames
Preconstructed framesets for laying out sites with
the need to manually design the commonly used
frame schemes. Used to divide up the browser into separate virtual screens.

Forms
Text fields, radio buttons, and everything you need to put together input forms. The elements of forms
enables the users to input data in a simple and familiar way.(We will not be using this to create school
webpages).

Templates
Elements for building template Web pages to distribute editing
responsibilities. ( Not used in an elementary school, usually this
responsibility falls on one person).

Characters
Special characters and symbols that cannot be typed directly into the design view

Media, Head, Script and Application are tabs which are for the advance web designers and will not
be covered in this inservice.



Creating Your Own Site

Develop a Site Map
Much like a storyboard “maps’ out the scenes of a play or film, a site map is a visual representation of the
pages, sections, and links within a Web site.

If the window does not open automatically, choose Site Files.

To create a new page, choose NEW
from the File menu.  Dreamweaver
MX will display the New Document
dialog box.

Select Blank Document-Category
Basic Page HTML
Create

                                                          



On the bottom of your
workspace you will see
all of your pages in a tab
format.  Select an
Untitled page and then
File/Save.

Save in your web
folder.

Don’t forget to create
and image folder.

File Name: Principal’s
Message

Save

Do this for all of your
pages.  You will see the
title for each page
appear on the bottom
tab.

In the site panel right mouse click onto your
index.htm and select

“Set as Home Page”

Title your home page with your school’s
name. This is the name that will appear in
the browser’s title bar when the page is
opened.



Background and Text Colours 

Right mouse click on your working page
and select Page Properties.  

Click on the down arrow next each
section of Background, Text and Links to
select the colours.

Positioning with Tables

In the most basic form, a table is nothing
more than a grid of cells, each of which
can contain whatever content you’d like: text, images, other tables, and so on.  What makes tables
complicated are the number of attributes and operations that can be performed on them and the cells
that make them up.  

Let’s Insert a Table and Images/Text on our Index Page.

From Menu Bar Select 

View/Table View/Standard

From the common tab move to tables.

Select the insert table
button

A dialogue box will appear...

Set the following attributes

OK

Cell Padding-How many pixels of
padding are around the inside edges of
a table cell

Cell Spacing- The number of pixels to be added to the outside edges of table cell.

Width-Widths specified as percentages grow and shrink with the overall size of the browser
window.

Border-The width, in pixels, of the border to be drawn around the table (0 for no borders).

Adding Content

Merging/Splitting Cells -Select modify from the menu bar, table, merge cells or highlight table
cells, right mouse click and select table-merge cells from the box that appears. etc.

Merge the first row of cells. Type your School’s Name.

As you click into a table cell to type in the captions, use the properties panel to set the horizontal



alignment-center, vertical alignment to middle and the width to 50%.

Selecting and Resizing Tables, Cells, and Rows

Size of Cell: move the cursor to edge of the table’s boundary, cursor turns into vertical lines, click
and drag boundary so that it moves.

You can force Dreamweaver MX to choose a table cell rather than its content by holding down the
control key and clicking the cell. Select the row in the same fashion-move cursor so it is just
touching the dotted boarder in front of the row, click will highlight all the cells in the row.

Precise Positioning-Create a table

Cell padding and spacing should be set to 0 in the properties will ensure that the contents of your
table cell will be exactly where you want them, not slightly skewed by the boarder.

Joining Cells and Nesting Tables:

to merge cells select the alt key and clicking in the cell to select, must be continuous blocks
of cells, select modify-menu’s table option... other effects

Slit Cell-Using the split cell option will create new cells in the selected table cell.  You will be
prompted for the number of rows or columns to create.

Insert Row/Column-The insertion features will insert a new row or coloumn directly before the
currently selected cell.  Choose the Insert Row or Columns item to choose what you want to insert
and where (before or after the current selection) you want to insert it.

Delete Row/ Column Span-Removes the row or column that contains the currently selected item.

Increase Row/Column Span-The row span and column span for a cell can be increated with these
options, you will need multiple cells selected for this frame.

Decrease Row/Column Span-If a cell is spanning multiple columns or rows, decreasing the row or
column span will shrink the current cell back to original position.

The Positioning Compromise:

Setting exact pixel size for tables and their cells lets the page designer position everything
perfectly.  Cells based on percentages will expand as the size of the browser is increased.

You can take this one step further by not setting any widths or heights for table cells. This lets the
content of the page drive its own layout.

You can clear cell heights and widths in menu modify then select clear cell.



After switching to layout mode there are two new tools you can use. 

1. Layout Table-You will draw a layout table in a region where you want total control, you can
precisely position page content.

2. Layout Cell-can be moved and resized after they are added to a layout table.  Clicking and
dragging the edge of a cell will move it within the table region.  Clicking the border of the cell a
single time will highlight the cell and add resizing handles to it.  

3. As you draw layout cells, small menus showing the current column width are added to the top of
the layout table.  These menus give you even greater control.  Clicking one of the menu headings
reveals a pop-up menu with options to control the cells and how they are generated:

• Make Column Autostretch-Sets the column so that it will automatically grow as needed to fit
the content.

• Add Spacer Images-Some browsers have problem keeping table cells to right size unless
the cells actually contains content.  Dreamweaver uses “spacer” images to fill the cells. 
These are single pixel transparent images that are stretched to the appropriate width and
height.

• Clear Cell heights-removes all height information from the cells in the table.

• Make Cell Widths Consistent-Generates equally sized cells.

• Remove All Spacer Images-Removes any spacer images that have been added to the table

• Remove Nesting-If you have nested tables to create a layout this option will flatten your
design into a single table

You can switch back to normal design by selecting view in the tool bar and table view-standard
view.

Spell Checker

Choose check spelling from the text menu

Preview in Browser-sub menu within the File menu

Preview in both explorer and netscape

 To add both browsers to your view- 

Go to Edit Preferences, Select “Preview in Browser”
select + to add Netscape (you much make sure that you
have downloaded Netscape 



Images:

To insert images-make sure cursor is located
where you want the image to appear (e.g. in a
cell).

• Insert

• Images

• Look in: wherever you have your images
store. 

Notice-Relative to-this will be set at document.
This means that the links will be created relative to
one another.

If you choose an image outside of your folder
Dreamweaver will give you the option of copying it
into your site. Dreamweaver will only display local
images not those in url’s.

Properties of images

Name-below the image,14k you may put in a name for your image.

Width/Height

Scr: The URL to the image that will be displayed

Link-If an image is to be used as a link add the URL in this field.

Alt-Alternative text to be displayed in case the images can’t be viewed or is to be read aloud by
browsers for the visually impaired. Use this feature often.

Vspace/HSpace-Set vertical and horizontal padding around the image

Target-Only used if image is a link.  This is usually left blank.

Low Src-Rarely used-sets image to black and white for quick display in browser while high
resolution loads up.

Border-Border around image

Align-Determines where an image will lie in relation to objects that are next to it.



Horizontal Rules:

• separates different types of contents

• Go to insert-horizontal line

• It will be insert wherever your cursor is located

• Once inserted check out it’s properties panel-width, height, and aligment as well as an
option to enable or disable shading of the rule.

Links-

Links is a hot spot which takes
readers from one page to another
or one spot on the page to another
within a given page. 

To add your first link, position
your cursor where it should
appear, then click the Hyperlink
object in the insert panel.  This
dialogue box will appear...

• Text: Principal’s Message 

• Click the folder next to Link: Choose Principal’s Message.htm file directly from your site
directory.

• Tab Index: Setting a tab index chooses the order in which the link will be highlighted when
the users press Tab to navigate the page.

• Access Key: This is a keyboard shortcut that can be used to access the link directly (not
used often).

Second  way to add links:

1. Highlight word that needs to be linked “Principal’s Message”

2. Using the link field in properties type in the word “principal’s message.html

3. Press enter

Third way to add links:

1. Highlight word that needs to be linked “Principal’s Message”.

2. Open your site file windows so you can see principal’s message.html.

3. In properties, target, use your mouse to drag from the crosshairs to the file in the site
window.

You can go back anytime and edit exisiting links through the Modify menu’s Change Link option, or
by editing existing links through the Modify menu’s Change Link option.

To Preview your web-Go to menu bar, file, Preview in Browser. 



 


